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Chapter

Overview

This document provides a series of step-by-step guides to help readers install and integrate the IAR
Embedded Workbench® toolchain within the Eclipse IDE on Microsoft Windows®. This document will
go over the installation and configuration required to use the IAR Embedded Workbench for Eclipse
plugin which is developed and distributed by IAR. The instructions written therein are primarily for the
IAR ARM Embedded Workbench (EWARM) which supports both building and debugging from within
Eclipse. Other editions of IAR for various targets are also supported but only for building. This guide is
also not aimed at Linux users. A separate installation of IAR is available to support building on Linux but
this is not covered in this guide. Note that there are many combinations of Eclipse and IAR versions as
well as more than one way of installing the IAR Eclipse plugin. This document is the recommended way
by JBLopen but customers are free to modify their development environment to suit their needs.

Readers are encouraged to also look at the official installation instructions for the IAR Eclipse Plugin
which can be found at http://eclipse-update.iar.com/.

1.1 About IAR Embedded Workbench

IAR Embedded Workbench is a complete set of compiler toolchain, debugger and IDE for embedded
software development targeting multiple CPU architectures and device manufacturers. Additional
information about IAR Embedded Workbench can be found on the IAR website.

A free code size limited edition of the IAR Embedded Workbench for ARM is available from the IAR
website. Additionally, users can activate a one time, full featured, 30-day trial licence. Both trial editions
can be used to test the steps included in this guide.

1.2 About Eclipse

Eclipse is a cross-platform IDE that supports multiple programming languages. This document will
mainly use the Eclipse CDT environment for C and C++. Additional information about the Eclipse IDE
can be found on the Eclipse.org website.
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Chapter

Tools Setup

This section will go over the Eclipse IDE and the IAR toolchain setup. The following instructions will go
through the installation and configuration of the following components in order:

e Eclipse - 2020.12 - eclipse-inst-jre-win64.exe
www.eclipse.org

¢ |AR Embedded Workbench for ARM - 8.50.9 - EWARM-CD-8509-33462.exe
www.iar.org

e MSYS2 (Optional) - 20200903 - msys2-x86_64-20200903.exe
WWW.msys2.0rg

The versions cited above are those that were used when writing this guide. Installation instructions for
newer versions, if available, should be similar.

2.1 Note About the Java Runtime Environment

Eclipse is now packaged with a suitable JRE. However using the JRE over a JDK may cause some
dependency issue when installing the IAR Eclipse Plugin. This guide will use JDK version 14. To ensure
that the JDK is used it must be installed prior to installing Eclipse and must be selected on the Eclipse
install dialog as shown in the guide.

2.2 Note About MSYS2 and Makefile Projects

The following guide includes instructions on how to install MSYS2. This is optional to use the IAR
Embedded Workbench within Eclipse and is only useful when creating Makefile projects which require
GNU Make to be available. Readers who are not interested in creating Makefile projects using IAR do
not need to install MSYS2 for the purpose of this guide.

2.3 IAR Embedded Workbench Installation

The first package to install is the IAR Embedded Workbench for ARM. Running the IAR installer,
EWARM-CD-8509-33462.exe in this example, the following dialog should appear.
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IAR Embedded =
Workbench %

+ Install IAR Embedded Workbench® for Arm
* Installation and licensing information

*» Release notes

* Install drivers

» Explore the installation media

* Exit K1 Japanese

Figure 1 - IAR installer

On the installer menu select "Install IAR Embedded Workbench for ARM”. This will start the IAR
EWARM installation wizard proper.

|AR Embedded Workbench for Arm 8.50.9 =

‘Welcome to the InstallShield Wizard for I1AR
Embedded Workbench for Arm

The InstallShield Wizard will install 14R Embedded
Wwarkbench for Arm on your computer. Ta cantinue, click
Mext,

< Back Cancel

Figure 2 - IAR EWARM installation welcome dialog

Click "Next” to display the license agreement.
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|AR Embedded Workbench for Arm 8.50.9 =

Licenze Agreement

Pleasze read the following license agreement carefully.

SOFTWARE LICENSE
AGREEMENT

August 2020

Concerningthe Products: Embedded Trust”™, |AR Embedded Workbench™ | 1AR
Visual State” v

(®1 accept the terms of the license agreement Print

(O | do nat accept the tems of the license agreement

< Back Cancel

Figure 3 - License agreement

Accept the license agreement and click "Next” again to move to the installation path selection screen.

AR Embedded Workbench for Arm 8.50.9 b4

Choose Destination Location

Select falder where setup will install files.

@ Install 14 Embedded Workbench for m to:

C:Miar_am Change...

< Back Cancel

Figure 4 - Installation path selection

The wizard will install the IDE within the usual "Program Files” directory. If, however, you intend to use
the IAR toolchain with custom Makefiles it is recommended to install IAR within a different directory
with a short path containing no spaces or special characters. In this example, C: /iar_arm will be used
as the installation directory.

Click "Next” to continue the installation wizard and display the drivers installation selection screen.
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AR Embedded Workbench for Arm 8.50.9

USB Driver installation

Select the USE divers to install for pour debug probes

Select the USE divers you want to ingtall on pour system

- Drescription
Diriver installers for debug
probes
A THCD
- TIFET
- A NU-LINK v

£.97 GE of space required on the C diive
99,49 GE of space available on the C dive

< Back Cancel

Figure 5 - Debug probe and dongle driver selection

By default all the debug probe drivers will be selected. Drivers that aren’t needed can be removed from
the selection if desired. Click "Next” to continue.

|AR Embedded Workbench for Arm 8.30.9

Select Program Folder

Please select a program falder.

Setup will add program icong to the Program Folder listed below. 'ou may tupe a new folder
name, or select one from the Existing Folders list. Click Mest to continue.

Program Folder:

E wisting Folders:
i [u]
Arceszibility
Accessones
Administrative Tools
Antidote

doxpgen

EFSON

GLCC for Renesas AX 8.3.0.202004-GNURX-ELF
Hourglass

< Back Cancel

Figure 6 - Windows start menu item dialog

Change the start menu entry if desired and click "Next” again.
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Select Program Folder

Pleaze select a program folder.

Sl W : L . e
han AR Embedded Workbench for Arm - InstallShield Wizard X
Pra
14 |AR. Systems Setup will now install dongle drivers on your
! system.
The driver installation for USE dongles might fail if a USE A

dongle
is attached to your computer during the installation.

You must remove all USE dongles before continuing,

v

< Back Cancel

Figure 7 - Dongle driver USB warning

If the dongle driver was selected in the driver selection screen, a warning dialog will be displayed
instructing the user to remove any IAR dongles present on the host machine before proceeding. Click
"OK" to dismiss the warning.

|AR Embedded Workbench for Arm 8,509 =

Ready to Install the Program
The wizard iz ready ta begin installation.

Click Install bo begin the installation.

If pou want to review or change any of pour inztallation settings, click Back. Click Cancel to exit
the: wizard.

< Back Inztall Cancel

Figure 8 - EWARM installation ready

Click "Install to begin the installation process which may take a few minutes.
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|AR Embedded Workbench for Arm 8.50.9 =

Setup Status

IAR Embedded Workbench for Arm is configuring your new software installation.

Installing

C:\...\pluginscom.ibm.icu_58.2.0.v20170418-1837 jar

Cancel

Figure 9 - EWARM installation underway

The installation will proceed and once finished the installation completed screen should appear.

|AR Embedded Workbench for Arm 8.30.9
InstallShield Wizard Complete

The InztallShield Wizard has successfully installed 1AR
Embedded Warkbench for A, Click Finizh to exit the wizard.

Wiew the release notes

< Back Cancel

Figure 10 - EWARM installation completed

On the installation completed screen, you have the option to view the release note which will open in
the default web browser. Otherwise click "Finish” to end the installation.

From the created start menu entry, launch the IAR Embedded Workbench that was just installed.
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IAR Embedded Workbench

Figure 11 - IAR Embedded Workbench for ARM splash screen

A splash screen will be displayed briefly while the IDE loads, then the IDE should appear.

© 1AR Embedded Workbench IDE - o x

Files - )

Ready CaP NUM OVR BE

Figure 12 - EWARM IDE

If there is no valid license installed on the host computer, the IAR License Manager will start
automatically. From there you can either install an available purchased license or request a code size
limited or time-limited evaluation license.
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?/ IAR License Manager 2.17.3 - IAR Embedded Workbench for Arm .50

File View | License | Tools Windows Help

MNetwaork Li Activate License...

[ 1AR Embed Chedk for License Renewal...
Version 8. Use Network License...
License ni
PC-locke: Transfer License... Arm, 32K Kickstart Edition 8.50

Deactivate License...

etails)

Get Evaluation License...

Starts the wizard for registring the product to get an evaluation license

Figure 13 - IAR License Manager

Follow the instructions on screen to install the selected license type.

Once done with the IAR installation and license setup close the IAR IDE for the moment to proceed
with the Eclipse installation.

2.4 Eclipse Installation

The next package to install is the Eclipse IDE. Begin by executing the installer file. Note that if possible
the 64-bit version of Eclipse is strongly recommended. In this example
eclipse-inst-jre-win64.exe, the following screen should appear.
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type filter text Q
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e
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Eclipse IDE for Java Developers

The essential tools for any Java developer, including a Java IDE, a Git client, XML
Editor, Maven and Gradle integration

Eclipse IDE for Enterprise Java Developers

Tools for developers working with Java and Web applications, including a Java IDE,
tools for Web Services, JPA and Data Tools, JavaServer Pages and Faces, Mylyn....

Eclipse IDE for C/C++ Developers

An IDE for C/C+H developers.

Eclipse IDE for Embedded C/C++ Developers

An IDE for Embedded C/C++ developers. It incdludes managed cross build plug-ins
(Arm and RISC-V) and debug plug-ins (SEGGER J-Link, OpenOCD, and QEMU), plus a...

Eclipse IDE for Web and JavaScript Developers

The essential tools for any Javascript developer, including JavaScript, TypeScript,
HTML, €55, XML, Yaml, Markdown... languages support Kubernetes, Angular and...

Figure 14 - Eclipse installation welcome screen
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Select "Eclipse IDE for C/C++ Developers” by clicking it. Note that it’s also possible to use the "Eclipse
IDE for Embedded C/C++ Developers” but the extra features provided by the embedded developers

edition aren’t useful when using the IAR Eclipse plugin.

The installation path and JVM selection dialog should appear.
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Eclipse IDE for C/C++ Developers
t"’” An |DE for C/C++ developers.

Java 11+ VM CA\Program Files\ava\jdk-14.0.2

Installation Folder Checlipse_iar

' create start menu entry

& create desktop shortcut

£ BACK

Figure 15 - Installation path and JVM selection
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v

In the first selection box, the Java Virtual Machine to be used by Eclipse must be selected. By default
the installer will automatically select a suitable JRE or JDK if one is found on the host machine.
Otherwise the bundled JRE will be used. As mentioned earlier in this guide, JDK version 14 or later is
recommended to prevent dependency issues when installing the IAR plugin. This guide uses JDK 14.0.2.

For the installation directory, it is recommended to use a unique directory that is short with no spaces in
the name as the eclipse install directory. In this example we will use C: /eclipse_iar as the install
directory. The eclipse installer will automatically create an eclipse subdirectory inside the specified
installation path. Finally, it is possible to create a start menu entry and/or a desktop shortcut if desired.

Click the "Install” button to begin the installation process.
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#r DONATE

ecnpSEinSta"er by Oompt

details

Eclipse IDE for C/C++ Developers

@. An |DE for C/C++ developers.

Java 11+ VM CA\Program Files\ava\jdk-14.0.2

Installation Folder Checlipse_iar

' create start menu entry

' create desktop shortcut

X Cancel Installation

Figure 16 - Installation progress dialog
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By default the installer will download Eclipse during the installation process which may take longer on
slow internet connections. An offline installer is available from eclipse.org if necessary.

The installation should eventually finish.
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by Oompt

Eclipse IDE for C/C++ Developers

ec-n-

An |DE for C/C++ developers.

Java 11+ VM CA\Program Files\ava\jdk-14.0.2

Installation Folder Checlipse_iar

' create start menu entry

& create desktop shortcut
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DONATE

details

» LAUNCH

show readme file

open in system explorer

keep installer

£ BACK

Figure 17 - Installation successful

Click "Launch” to check that the Eclipse installation works properly. The workspace selection dialog

should appear.

S Eclipse IDE Launcher

Select a directory as workspace

Eclipse IDE uses the workspace directory to store its preferences and development artifacts.

9
Workspace: | (STl

[[] Use this as the default and do not ask again
» Recent Workspaces

Browse...

Cancel

Figure 18 - Workspace selection dialog

It is strongly recommended to create a unique workspace that will be used exclusively for the projects

13

related to the IAR toolchain that will be installed in this guide. The workspace selected should not have

a path name that is excessively long and it is recommended not to use spaces in the path name either.

For the purpose of this guide C: /eclipse_iar_workspace will be used as the workspace.

Click "Launch”.
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eclipse IDE

2020-12

Starting Eclipse IDE
]

Figure 19 - Eclipse splash screen

After a few seconds, the Eclipse welcome screen should appear.

S eclipse_iar_workspace - Eclipse IDE - m} X
File Edit Source Refactor Mavigete Search Project Run  Window Help

‘5 @ Welcome 12 =5

(% EC“pse Welcome to the Eclipse IDE for C/C++ Developers ®

A guided walk-through how to import an existing Get an overview of the features
project

" . Go through tutorials
Review the IDE's most fiercely contested preferences

. . . Try out the samples
Create a new Eclipse project for C/C++ source code

. . Find out what is new
Open the New item wizard

Checkout Eclipse projects hosted in a Git repository

Import existing Eclipse projects from the filesystem
or archive

O Always show Welcome at start up v

Figure 20 - Eclipse welcome screen

2.5 IAR Embedded Workbench for Eclipse Installation

After having installed Eclipse and the IAR Embedded Workbench it is now time to install the IAR Eclipse
plugin manager and register the IAR ARM toolchain installed previously.
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Launch Eclipse if it's not already started. The workspace selection dialog should appear.

S Eclipse IDE Launcher e

Select a directory as workspace

Eclipse IDE uses the workspace directory to store its preferences and development artifacts.

Workspace: | TR “| Browse..

[[] Use this as the default and do not ask again

» Recent Workspaces

Figure 21 - Workspace selection dialog

If one wasn'’t created earlier, you must select a directory for the Eclipse workspace. It is strongly
recommended to create a unique workspace that will be used exclusively for the projects related to the
IAR toolchain that will be installed in this guide. The workspace selected should not have a path name
that is excessively long and it is recommended not to use spaces in the path name either. For the
purpose of this guide C: /eclipse_iar_workspace will be used as the workspace. Click "Launch” to
open the Eclipse IDE with the selected workspace.

First things first, find the well hidden "Install New Software” from the Help menu.

un  Window Help

Zonfigurations | @8l Welcome I

(Z) Help Contents

4 Search
= 75 o
Show Contextual Help ]
Show Active Keybindings... Ctrl+5Shift+L T
#« Tips and Tricks... p

Cheat Sheets...

Eclipse User Storage »

% ®

Perform Setup Tasks...

Check for Updates
Install Mew Software...
Eclipse Marketplace...

About Eclipse IDE

4 &

Donate

Contribute

Figure 22 - Install New Software menu item

Clicking it will open the Eclipse update site manager.
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-
= Install

Available Software

Select a site or enterthe location of a site.

Add..

IR RIE: o o select a site

[type filter text

Name Version

0@ There is no site selected.

Details

Show only the latest versions of available software Hide items that are already installed

Group items by category What is already installed?
[ Show only software applicable to target environment

Contact all update sites during install to find required software

@ Next > Finish

o x

-
o

Manage.

Select All

Deselect All

Cancel

Figure 23 - Install New Software dialog

Type http://eclipse-update.iar.com/plugin-manager/1.0 in the "Work with:” field and
press enter. The screen should update to show the available software from the IAR update site.

S Install o e
Available Software

Check the items that you wish to install, ) =
Work with: | http://eclipse-update.ar.com/plugin-manager/1.0 v Add... Mznage...
[type fiter text Select All

Name Version Deselect All
~ [Z1000 1AR Systems

[ 6 1R Plugin Manager 1.1.0.202011160859

1 item selected

Details
Show only the latest versions of available software Hide items that are already installed
Group items by category What is already installed?
[ Show only software applicable to target environment
Contact all update sites during install to find required software

@ < Back Finish Cancel

Figure 24 - Install New Software selection

Expand the "IAR Systems” line item and click the checkbox next to "IAR Plugin Manager”. Then click
"Next” to be taken to the installation summary screen.
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< Install u} X
Install Details

Review the items to be installed, D~
Name

Version Id

(- 14R Plugin Manager 1.1.0.202011160859 com.iar.dmgrfeature.festure.group

Size: 4253 KB
Details

<Back Finish Cancel

Figure 25 - Installation summary screen

Click "Next” again to be taken to a license agreement screen.

-
< Install

o X
Review Licenses
Licenses must be reviewed and accepted before the software can be installed. D =

License text (for IAR Plugin Manager 1.1.0.202011160839):
IAR SOFTWARE LICENSE AGREEMENT

Concerning the Products: AR Embedded Workbench(R) and visual STATE(R)
from IAR Systems AB December 2011

PREAMBLE

THIS SOFTWARE LICENSE AGREEMENT (" THE AGREEMENT") APPLIES TO PRODUCTS
LICEMSED BY IAR SYSTEMS AB INCLUDING ANY OF TS SUBSIDIARIES ("IAR
SYSTEMS") OR DISTRIBUTORS ("IAR DISTRIBUTORS"), TO YOU (“THE LICENSEE").

The arder confirmation from IAR Systems, or when applicable the

@ | accept theterms of the license agreement

(1 do not accept the terms of the license agreement

@
@

<Back Next > Cancel

Figure 26 - Plugin license agreement

Make sure to accept the license and click "Finish”. The installation will proceed with the progress
displayed in the right bottom corner of the IDE. Do not close Eclipse until the installation completes.

= Security Warning O s

Warning: Installing unsigned software for which the authenticity or validity cannot be
! . established. Continue with the installation?

Install anyway Details = »

Figure 27 - Plugin installation security warning

It's possible that a warning dialog appears warning against installing unsigned content. Click "Install
anyway” to progress with the plugin installation.
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= Software Updates *

'.l;ol.' Restart Eclipse IDE to apply the software update?

T [

Figure 28 - Restart prompt after plugin installation

Eventually, when the installation has completed, a dialog prompt will ask to restart Eclipse to enable the
newly installed plugin. Do so by clicking "Restart Now”.

_ O x

indow | Help

rations @ Welcome B

- () Help Contents N E:A‘ -
% Search

2= Ou... @Bu. = B
Show Contextual Help b ]

Show Active Keybindings... Ctleshiftel | e editor that

Tips and Tricks... provides an outline.
Cheat Sheets...

o

Eclipse User Storage >

% ®

Perform Setup Tasks... The IAR Embedded Workbench plugin manager helps you to install the correct version of
the toolchain and debugger plugins.

Check for Updates
Install New Software...
Eclipse Marketplace...
IAR Embedded Workbench plugin manager...

About Eclipse IDE
Donate
Contribute

40 B G

Figure 29 - IAR plugin manager menu item

After the IDE restarted, there will be a new menu item under the "Help” menu named "IAR Embedded
Workbench plugin manager”. Click it to open the manager.

Progress Information

"6" Operation in progress...

Fetching contentxml.xz from http://eclipse-update.iar.com/vB50/4.10/ (16.41kB)

Figure 30 - |IAR plugin manager loading

Loading the manager for the first time might take a few seconds as it queries the updated plugin online.
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= AR Embedded Workbench plugin manager

Manage IAR Embedded Workbench Eclipse plugins

Select your target in the left pane, then select a plugin to install in the right pane.

Supported targets Available IAR Embedded Workbench installations

Target Installed plugin o Version Status IAR Embedded Werkbench Installation path

430 (6.50) -- not installed -- ) 8501 28 Plugin available C:\Program Files (x86)\IAR Systems\Embedded Workbench 8.4
430 (.20 to 6.40) - notinstalled -- 8.50.9 28 Plugin available Chiar_arm

78K (= 4.71) - notinstalled --

ARM (6.50.x) - notinstalled --

ARM (8.10-8.22) -~ notinstalled --

ARM (8.30-8.50) - not installed --

ARM (7.20 to 7.80) -- not installed --

R32C (>= 1.30) -- not installed --

RH850 (1.10 to 1.40) -- not installed --

RH850 (>= 2.10) -- not installed --

RL78 (»= 2,10, <= 3... -- notinstalled --

RL78 (1.x) -- not installed -- A

< > < >

®

Add AR Embedded Workbench installation...

Install

Cancel

Figure 31 - IAR plugin manager

Once fully loaded the manager will display all the different versions and targets supported by the IAR
Eclipse plugin. Clicking on "ARM (8.30-8.50)" should display the toolchain installed earlier in this guide.

Select the installed toolchain, here in this example it is version 8.50.9 installed in the iar_arm directory.
Note that any other existing installation will also be displayed as shown in the example there was an
existing installation of IAR 8.50.1 in the program files directory. If it is the case that more than one
toolchain is displayed make sure you select the one you want to use within Eclipse. After selecting the

toolchain click "Install”.

S Install u}
Install
Check the items that you wish to install. Y ~
Name Version Id
(i 1AR C-5PY Debug Support for ARM (8.30x-8.50) 2202020101213 com.er.cdtarm debuggerfeature featur..
[§i14R Common Compenents 3.0.0202011101213  com.iar.common feature feature.group
[ 1AR Common Debugger Components 200.202011101213  com.iar.common.debugger feature.featu..
(1R Toolchain for ARM (830 - 8.50.) 21.0.202011101213  comiar.cdtarm.sdk.feature feature.group
Select All Deselect All
Details
@ <Back Finish Cancel

Figure 32 - |AR plugin manager install selection

In the Install screen make sure to select all the available components to install. While it may be possible
to remove one of the components if it's not needed, this can cause issues later. Click "Next” to proceed.
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< Install u} X
Install Details
Review the items to be installed. D -
Name Version Id

[ 1AR C-SPY Debug Support for ARM (8.30.-8.50.x) £.2,0.202011101213 com.iar.cdt.arm.debugger feature....

(= IAR Comman Components 3.0.0.202011101213 com.iar.common feature feature.q...

[ 1AR Commen Debugger Components 2.0.0.202011101213 com.iar.commen.debugger.featur...

8.1.0.202011101213 com.iar.cdt.arm.sdk feature featur.

(g 1AR Toolchain for ARM (830 - 8.30.x)

Size: 23,182 KB
Details

@ < Back Finish Cancel

Figure 33 - IAR plugin manager install summary

On the installation summary screen click "Next” again to be taken to another license agreement screen.

S Install o *
Review Licenses
Licenses must be reviewed and accepted before the software can be installed. D
Licenses: License text

Eclipse Foundation Software User Agresment SOFTWARE LICENSE AGREEMENT

SOFTWARE LICENSE AGREEMENT Concerning the Products: IAR Embedded Workbench® and IAR

Visual State® from IAR Systems AB
PREAMBLE

THIS SOFTWARE LICENSE AGREEMENT ("THE AGREEMENT")
APPLIES TO PRODUCTS LICENSED BY IAR SYSTEMS AB INCLUDING
ANY OF ITS SUBSIDIARIES (*IAR SYSTEMS") OR DISTRIBUTORS ("IAR
DISTRIBUTORS"), TO VOU ("THE LICENSEE")

The order confirmation from IAR Systems, or when applicable the
agreement between |AR Systems and the Licensee, will set out,
apart from the applicable licensed product and license fee (whic

1iactinn ic 2

il alc e ctated in the Inunicel ) if the |irence in o

@)1 accept the terms of the license agreements

(O do not accept the terms of the license agreements

@ <Back Next > Cancel

Figure 34 - |AR plugin manager license agreement

Make sure to accept the various licenses and click "Finish”. The installation will proceed, again the
progress is displayed in the lower right corner of the IDE. Once finished another prompt to restart

Eclipse will appear.

= Software Updates

Restart Eclipse IDE to apply the software update?

(o]

Figure 35 - |IAR plugin manager restart prompt

Click "Restart Now” to restart Eclipse. If all went well, the IAR toolchain is now usable within Eclipse.
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= eclipse_iar_workspace - Eclipse IDE - m] x
File Edit Source Refactor Navigate Search Project Run Window Help

o 6% Welcome 3% i £ AE==#
. Overvi T /@ "
verview
Tutorials Samples What's New Workbench

o

Open the documentation for the IAR SDK for ARM

o

Open IAR Embedded Workbench Information Center
containing documentation, articles, sample projects,
etc.

Learn about basic Eclipse workbench concepts

)

Get familiar with the C/C++ Development Tools

©

Learn about Git in Eclipse by reading the EGit User
Guide

Install Eclipse extensions and solutions

Figure 36 - IAR Eclipse welcome screen

2.6 MSYS2 Installation

MSYS2 is used to provide the GNU Make utility and is not necessary to use the IAR Eclipse Plugin but
can be useful when writing Makefile projects. There are multiple options when it comes to installing a
basic UNIX environment in Windows, including the well-known Cygwin. This guide will use MSYS2 since
it offers superior build performance and good compatibility with native Windows paths. If compatible
with the host system, the 64-bit version of MSYS2 is recommended, which is labelled x86_64.

The installation can be started by executing the executable installation file, in this example
msys2-x86_64-20180531.exe, the following screen should appear:

IAR Embedded Workbench Eclipse Setup Guide www.jblopen.com


https://www.jblopen.com

JBLopen
Embedded Software Insight Chapter 2

M3YS2 64bit Setup

Setup - MSYS2 64bit

Welcome to the MSYS2 64bit Setup Wizard.

Mext Quit

Figure 37 - MSYS2 installation welcome prompt

Click Next.

MSYS2 64bit Setup

Installation Folder

Please specify the directory where MSYS2 64bit will be installed.

|C:'|,ms3r564 Browse...

Figure 38 - MSYS2 installation directory prompt

Tools Setup

22

Enter the desired installation directory, the installation directory should be short with no spaces in the

path. This guide will assume that the default installation directory of C: /msys64 is used. Click Next.
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€« M3Y52 6dbit Setup

Start Menu shortcuts

Select the Start Menu in which you would like to create the program's shortcuts. You can also
enter a name to create a new directory,

MSYS2 64bit

Accessibility
Accessories
Administrative Teols
Atlassian

Digilent

Eclipse

Graphviz 2.38

Mext Cancel

Figure 39 - MSYS2 installation start menu shortcut prompt

The installer will now prompt for the name of the start menu shortcut. It is recommended to use the
default name. Click Next.

<« M5YS2 64bit Setup

Installing MSYS2 64bit

Instaling component M5YS2 64bit base

36%

Show Details

Install Cancel

Figure 40 - MSYS2 installation progress screen

Installation should begin.

IAR Embedded Workbench Eclipse Setup Guide www.jblopen.com


https://www.jblopen.com

JBLopen
Embedded Software Insight

Chapter 2 Tools Setup | 24

M3YS2 64bit Setup

Completing the MSYS2 64bit Wizard

Click Finish to exit the MSYS2 64bit Wizard.
Run MSY52 64bit now.

Finish

Figure 41 - MSYS2 installation finished screen

The installation should finish successfully. Make sure that "Run MSYS2 64 bit now.” is checked.
M

Figure 42 - MSYS2 console

The MSYS2 console should open. It is now necessary to perform an update of the MSYS package
manager by typing:
pacman -Syu

And press enter.
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Figure 43 - MSYS2 package manager update prompt

After downloading the update information, a prompt will appear to ask for permission to proceed with
the installation. Type Y and press enter to continue.

Download and installation will proceed, this can take several minutes depending on network connection
and computer performance.

Figure 44 - MSYS2 package update restart request

It is likely that a warning message is displayed at this point asking to return to the shell and restart the
update process. When this occurs exit the MSYS2 console by pressing the X button on the top right

corner of the window. It is important to quit the console that way otherwise the warning may reappear
in the next invocation.
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Processes are running in session:
Close anyway?

Cancel

tion for opt/

Figure 45 - MSYS2 window close confirmation

A warning message will be displayed, press OK to proceed with the close.

Open the MSYS2 console again by navigating to the start menu item for MSYS2 and clicking MSYS2
MSYS.
Atlassian
I Desktop
Maintenance
MSYS2 64bit
MSYS2 MinGW 32-bit
MSYSZ2 MinGW 64-bit
MS5YS2 MSYS
Stardock
Startup

| Inivercal Annliratinng

Figure 46 - MSYS2 start menu entry

Once opened type:

pacman -Su

And press enter to continue the update process.
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gzip-1.10

Tibnghttp2-1 1 Tibnpth-1.
1 bpll-kit- .15-1  Tik

10

Figure 47 - MSYS2 package manager update prompt

A prompt asking for permission to continue will appear again. Type Y and press enter to continue.

Download and installation will proceed, like the previous step this can take several minutes depending
on network and computer performance.

Installation should complete without any error or warning messages.

Figure 48 - MSYS2 package manager update done

With the package manager updated and synced it is time to install the basic development utilities. This
can be achieved by typing:

pacman -S base-devel

A list of packages to be installed will appear.
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wrapper

Figure 49 - MSYS2 base-devel prompt

Press Enter to continue.

M|

apper-11-1

Figure 50 - MSYS2 base-devel installation confirmation prompt

Type Y and then Enter to continue.

Download and installation will proceed, this can take several minutes depending on network and
computer performance.
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Figure 51 - MSYS2 base-devel installation completed

The installation should complete without any error or warning messages.

To test that the installation is functional, let’s run a simple test by invoking the make utility as such:

make -v

The make utility should output its version information in the console.

Figure 52 - MSYS2 make test output

MSYS2 and the required utilities are now installed, the console window can be closed.
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2.7 Environment Variable Setup

For the MSYS2 executables to be easily accessible by Eclipse, Make and other utilities it is preferable to
have the toolchain binary location in the PATH environment variable. Note that these steps are not
required if MSYS wasn't installed.

2.7.1 PATH Environnement Variable Setup
Start by opening the Windows Control Panel.

E& Al Control Panel ltems

4~ B8 > Control Panel > All Control Panel ltems

Adjust your computer's settings View by:  Smallicons ~

& Administrative Tools g AutoPlay E} Backup and Restore (Windows 7) K1 Color Management

Credential Manager

s Devices and Printers

Flash Player (32-bit)

€1 Intemet Options

:‘: Metwork and Sharing Center
[ Programs and Features

P Security and Maintenance
'@ Sync Center

82, User Accounts

Date and Time
@ Ease of Access Center
A Fonts
| £ Java
B nvIDIA Control Panel
@ Recovery
iy Sound
A system

G Windows Defender Firewall

’-701 Default Pregrams

B File Explorer Options

¢u Indexing Options

E= Keyboard

|| Phone and Modem

> 4 Region

@1 Speech Recognition

L, Taskbar and Navigation
ﬂi Windows Mobility Center

A Device Manager

&) File History

f Infrared

@ Mouse

E Power Options

3 RemoteApp and Desktop Connections
& Storage Spaces

& Troubleshooting

[ Work Folders

Click "System”.
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All Control Panel ltems System

Control Panel Home

% Device Manager
®) Remote settings
) System protection

E; Advanced system settings

Seealso

Security and Maintenance

View basic information about your computer

Windows edition
Windows 10 Home
© 2018 Microsoft Corporation. All rights reserved.

R Windows10

System
Processor: Intel(R) Core(TM) i7-36300M CPU @ 2.40GHz 240 GHz
Installed memory (RAM): 120 GB
System type: 64-bit Operating System, x64-based processor

Pen and Touch: Mo Pen or Touch Input is available for this Display

Computer name, domain, and workgroup settings

Computer name: DESKTOP-8F60313 ®)Change settings
Full computer name: DESKTOP-8F60313
Computer description:
Workgroup: WORKGROUP
Windows activation
Windows is activated Read the Microsoft Software License Terms hd

Figure 54 - Windows system settings

Click "Advanced System Settings”.
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System Properties >

Computer Name Hardware Advanced  System Protection Remote

You must be logged on as an Administrator to make most of these changes.

Performance

Visual effects. processor scheduling, memony usage, and virtual memary

|ser Profiles
Desktop settings related to your sign-in

Settings. ..

Startup and Recovery
System startup, system failure, and debugging information

Settings. ..

Environment Variables...

QK Cancel

Figure 55 - Windows Advanced System Settings
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Click "Environment Variables”.

Environment Variables X

User variables for jblopen

Variable Value

OneDrive Ch\Users\jblopen\OneDrive

TEMP ChUsers\jblopentAppDatatLocal\ Temp
TMP ChUsers\jblopeniAppData\Local\Temp

Edit... Delete

System variables

Variable Value ~

ComSpec CAWindows\system32\cmd.exe

DriverData CAWindows\System32\Drivers\DriverData

NUMBER_OF_PROCESSORS ]

os Windows_NT

Path C:\Program Files (x88)\Common Files\Oracle\Java\javapath; C:\Win...

PATHEXT COM: EXE:;.BAT: CMD:.VBS:.VBE: J5: JSE:.WSF:. WSH:.MSC

PROCESSOR ARCHITECTURE  AMDE4 hd
New... Edit... Delete

Figure 56 - Windows environment variable configuration panel

In this screen, if an existing PATH environment variable exists, click it and then click "Edit..." otherwise
click "New..

New User Variable >

Variable name: | PATH ‘

Variable value: | Chmsysbusiibin; Checlipse_gechgecibin ‘
Browse Directory... Browse File... Cancel

Figure 57 - Windows new environment variable dialog

The path should be added either to the existing PATH variable or a new one. The usr/bin
subdirectory of the MSYS2 installation should be used. For the install directory chosen for this example,
this results in the following path:

C:/msys64/usr/bin;

Then click OK.
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Environment Variables

User variables for jblopen

Variable Value

OneDrive C\Users\jblopenOneDrive

bin; Checlipse_gecigecibin
TEMP Ch\Users\jblopen\AppData'Local\Temp
TMP Ch\Users\jblopen\AppData'Local\Temp
New... Edit... Delete

System variables

Variable Value

ComSpec CAWindows\system32\emd.exe

DriverData CAWindows\System32\Drivers\DriverData
NUMBER_OF_PROCESSORS 8

as Windows_NT

Path C:\Program Files (xB8)\Common Files\Oracle\Java\javapath: C:\Win...
PATHEXT COM: EXE:.BAT: CMD:.VBS:.VBE: J5: JSE: WS WSH:.MSC
PROCESSOR ARCHITECTURE AMD64

New... Edit... Delete

Figure 58 - Configured environment variables

Then OK again to exit the Environment Variables window.
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Managed Build Project Setup

Broadly speaking there are two types of projects that can be created with IAR Eclipse. The first is a
managed build project where the IDE is responsible for the various build steps. The second is a Makefile
project where the user is responsible for providing a suitable Makefile to perform the building and linking
of the project source code. The latter is discussed in a later section of this manual while this section will
go over the steps necessary to create a managed build project. The project created in this section will
be used afterward to demonstrate debugging a managed build project. Note that these instructions are
generic and the steps required may be slightly different depending on the target platforms.

3.1 IAR Eclipse Managed Build Project Setup

After having opened Eclipse with a suitable workspace as discussed in the previous sections, creating a
new managed build project can be accomplished first by invoking the "File->New->C/C++ Project”
menu item.
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3 eclipse_iar_workspace - Eclipse IDE

File Edit Source Refactor Navigate Search Project Run  Window Help

This should open the "New C/C++ Project” dialog.

New Alt+Shift+N > [T Makefile Project with Existing Code
Open File... ¢} C/C++ Project
(3 Open Projects from File System... ™ Project... Create s new Cor Co e praject
Eecentlipe ’ Convertto a C/C++ Autotools Project
Close Editor Crl+W Convert to a C/C++ Project (Adds C/C++ Mature)
Close All Editors Ctrl+Shift+W &% Source Folder
Save Citrs |& Folder
e (¢ Source File
o .
Save Al Ctrl+Shift~5 | (B HeaderFile
_ [% File from Template
& Class
Move...
[ Rename.. F2 i EEnoihe
& Refresh F5 [ Other.. Ctrl+N
Cenvert Line Delimiters To >
Print... Ctrl+P
g Import..
5 Export..
Properties Alt+Enter
Switch Warkspace >
Restart
Exit
[#1 Problems 32 2] Tasks [E) Console [T] Properties
0items
. . .
Figure 59 - Create New C/C++ Project menu item
S Mew C/C++ Project m} x
Templates for New C/C+~+ Project
€ Managed Build ~
CMake C" A C Project build using the CDT's managed build system.
Make
Meson
C++ Managed Build
c" A C++ Project build using the COT's managed build system.
CMake Project
A CMake project with a Hello World executable to get started
Empty or Existing CMake Project
Create o CMake project with no files. Can be
wused to create one over existing content.
Empty or Existing Meson Project
M Create o Meson project with no files. Can be o
P e S
< >
" -
@ < Back Finish Cancel

Figure 60 - New C/C++ Project dialog

Select "C Managed Build” and then click the "Next” button.
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default

Project type:

=] ] x
C Project —
Create C project of selected type
Project name: | iar_managed
Use default location
Ciheclipse_iar_workspaceliar_managed Browse...

Toolchains:

7= GMNU Autotools
= Executable
~ (= Executable (IAR)
& Empty Project
® Project with empty main()
= Library (IAR)
(7= Shared Library
(7= Static Library
7= Makefile project

|AR Teolchain for ARM - (8x)
|AR Toolchain for ARM - (legacy, 7.x)

'\/‘7\' < Back

Show project types and teolchains only if they are supported on the platform

Figure 61 - New project name and type selection

In this next panel, the project name and type must be selected. First enter the desired project name.
Then select the "Empty Project” item from under the "Executable (IAR)” category. Next, make sure that
the "IAR Toolchain for ARM - (8.x)” option is selected unless you are using an older, legacy version of

the IAR toolchain.

Click "Next” to continue with the wizard. Note that it is possible to exit the wizard by clicking "Finish”

but this will skip the device selection step.

IAR Embedded Workbench Eclipse Setup Guide

www.jblopen.com


https://www.jblopen.com

JBLopen
Embedded Software Insight

Chapter 3 Managed Build Project Setup | 37

-
-~
Select Configurations

Project type: Executable (|AR)

Toolchains: |AR Toolchain for ARM - (8x)

Configurations:

Select platforms and configurations you wish to deploy on

i Debug
%3 Release

I:?:' < Back MNext =

Use "Advanced settings” butten to edit project’s properties.

Additional configurations can be added after project creation.
Use "Manage cenfigurations" buttons either en toolbar or on property pages.

Select all

Deselect all

Cancel

Advanced settings...

Figure 62 - New project build configurations

This next panel shows the build configurations for the project to be created. For the purpose of this

guide, it is recommended to keep the default values.

Click "Next” yet again to continue further to the device selection dialog.

IAR Device Selection

Select a device

Device

NXP MCIMX7DT_AT

Browse...

lf?} < Back Mext =

O

Cancel

*

Figure 63 - IAR Device Selection dialog

In the device selection dialog select the target device for the new project. This example uses the A7
core of the NXP i.MX7 SoC but any of the supported targets can be used.

Click "Finish” to exit the wizard and create the project. The newly created project should appear in the

workspace on the left panel of the IDE.
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To demonstrate building and debugging this example uses an empty main function.

= eclipse_iar_workspace - Eclipse IDE

File Edit Source Refactor Mavigste Search Project Run Window Help

&][o][s][-

B A&

{5 Project

Mo Launch Configurations

ERNCASE R R BNy J=g

New > % Project...
Go Into 3
v 5 iar_r File
5l Open in New Window “ File from Temnlats
a
N Show In Alt=Shift+W > | (5 Folder
Show in Local Terminal * @ Closs
[® Copy Cti+C  [K HeaderFile
Paste Crl+V | [¢] SourceFile
% Delete Delete &9 Source Folder
Source P /e Project
Move.. Convert to a C/C++ Project (Adds C/Co++ Nature)
Rename... F2
I Exemple..
24 Import.
-
ey Export.. [ Other.. Ctrl+N
Build Project
Clean Project
Refresh F5

Close Project

Close Unrelated Project

Build Taroets

Figure 64 - Add new file to project context menu item

>

[mif 57

= E

To add the example file to the project right-click on the project root in the workspace and select
"New->File". This opens the new file dialog.

= Create New File

File

Create a new file resource.

Enter or select the parent folder:

iar_managed

=% iar_managed

File name: | main.c

Advanced > >

Cancel

Figure 65 -

Name the new file main. c and click "Finish”.
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S eclipse_iar_workspace - iar_managed/main.c - Eclipse IDE

File Edit Source Refactor Mavigate Search Project Run Window Help

@ No Launch Configuratiens

= T EET I H O AR
[¢) Project Explorer 52 = B [ maine 5
B25 Y § e
w5 o managed void main(void)
[l Includes for(33) {
B o
4 NXP MCIMXTD7_A7 H

D items

Description

sl nid-freF e Q E|l@

[®) Problems 32 J%] Tasks E] Console [T Properties

Resource Path Location Type

Writable Smart Insert

- o x
mi R S

= 8 gou. @Bu. = 0O
e EIRRY e % §

©  main(void) : void

#°ARToolchai.. 32 = B
B % &
7 1AR Toolchain for ARM - (3

7§ =8

Figure 66 - Empty main function

The new file is now showing in the project and should be open in the IDE. Type the following empty

function into the newly created file before continuing.
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void main(void)
{
for(5;) {

3

Listing 1 - Example main function with infinite loop

= eclipse_iar_workspace - iar_managed/main.c - Eclipse IDE
File Edit Source Refactor Mavigate Search Project Run  Window Help
@ --- ~ || Mo Launch Cenfigurations
=Y AR E O @D -
55 Project Explc Mew N
Go Into
~ [£ iar_manai
[ Includ Open in New Window
[ main.c Show In Alt+Shift+W >
& NPV Show in Local Terminal b
B Copy Ctrl+C
Paste Ctrl+V
W Delete Delete
Source b
Move...
Rename... F2
v Import.
3 Export..
Build Project Incremental Build of Selected Projects
Clean Project
Refresh F5
Close Project
Close Unrelated Project
Build Targets 3

Figure 67 - Build project context menu item

Now right-click again on the root of the project and select "Build Project”. This should start building the
project. Note that you might get errors if a valid IAR licence isn’t available for the IAR toolchain. See the
previous sections on how to request an evaluation licence.
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S eclipse_iar_workspace - iar_managed/main.c - Eclipse IDE - [m} X
File Edit Source Refoctor Navigate Search Project Run Window Help
(0] No Leunch Configurations on: |- - | B-&-BiBiwis-
B~ -G~ B0~ - G-®mp - Bt Q ®|E
By Projec.. 32 = O [§ mainc 5 = O 5= outiine ¥ @EBuildTa. = O

X521 N 5% WAl o W
15 iar_managed void main(void) o mainivoid): void
4 Binaries for(s:) {
5l Includes
(= Debug 1
[&] main.c ¥ N -
& e vz, © #” 1AR Toolchain Explorer 3 =
SR
&~ AR Toolchain for ARM - (8x)
[#] Problems ) Tasks [ Console 32 [T Properties X 3 oE BEEEErR-m-=8
CDT Build Console [iar managed]
-
Errors: none
warnings: none
ilinkarm main.o -o iar_managed.out --config C:/iar_arm/arm/config/linker/NXP/MCIMITD_A7.icF --no_wrap_disgnostics --semihosting
~-text_out locale --no_bom
IAR ELF Linker V8.5€.9.278/wW32 for ARM
Copyright 2887-2828 IAR Systems AB.
334 bytes of readonly code memory
68 bytes of readwrite code memory
82 bytes of readonly data memory
§'784 bytes of readwrite data memary
Errors: none
Warnings: none
Link time: @.85 (CPU) .06 (elapsed)
10:38:58 Build Finished. & errers, @ warnings. (took 637ms)
< > v

Figure 68 - Example project built

Before long the project should be built and is now ready to be loaded to a target for debugging. The
next section will cover debugging a managed build project.

3.2 IAR Eclipse Managed Build Project Debugging

With a built project, it is now time to setup a debug configuration for the project and launch a debug
session.

Start by searching for and clicking the "Run->Debug Configurations” menu. Not that while it is possible
to create a debug configuration by right-clicking the project root and selecting "Debug as.” this will
launch a debug session without having the chance to configure it first which is almost certainly not the
desired outcome.
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sged/main.c - Eclipse IDE

qgate  Search Project Run  Window Help
@, Run

Mo Launc ™5
Debug

i
- 0‘@:"5‘95 Profile

=5 :
MAE Drofile History

Profile As
Profile Configurations...

C++ Exceptions

Run History
Run As

Run Configurations...

Debug Histary
%5 Debug As
Debug Configurations..,

Breakpoint Types

Teggle Breakpoint
Teggle Line Breakpoint
Toggle Watchpoint

Toggle Method Breakpoint

®  Skip All Breakpoints

Remove All Breakpoints

@, External Tools

[®0 Problems 52 J=) Tasks B Console [T Properties

0 items
~

Description

Ctrl+F11
F11
Sr oo

>

»

>

>

>

»

>

>
Ctrl+Shift+B
Ctrl+Alt+B

>

Resource Path

Figure 69 - Debug Configurations menu item

The Debug Configurations panel should appear.

s Debug Configurations

Create, manage, and run configurations

CE |8 7 -~

[E] C/C++ Application

[E] C/C++ Attach to Application
[E] C/C++ Container Launcher
[E] C/C++ Postmortem Debugger
[€] C/C++ Remote Application
Cif C/C++ Unit

[] GDB Hardware Debugging
© AR C-SPY Application

R Launch Group

Filter matched 9 of 9 items

'
(?/.

Configure launch settings from this dialog:
| - Press the "New Configuration’ button to create a configuration of the selected type.
- Press the 'Mew Prototype' butten to create a launch configuration prototype of the selected type.
- Press the 'Export’ button to export the selected configurations,
“=| - Press the 'Duplicate’ button to copy the selected configuration.
3 - Press the 'Delete’ button to remove the selected configuration.
|/ - Press the Filter' button to configure filtering options.
- Edit or view an existing configuration by selecting it.
IL| - Select launch configuration(s) and then select 'Link Prototype’ menu item to link a prototype.
- Select launch configuration(s) and then select 'Unlink Prototype' menu item to unlink a prototype.

- Select launch configuration(s) and then select '.. Values' menu item te reset with prototype values,

Configure launch perspective settings from the 'Perspectives’ preference page.

Debug Close

Figure 70 - Debug Configurations panel
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On this panel right-click on "IAR C-SPY Application”.

[E] C/C++ Postrortem Debugger
[E] C/C++ Remote Application
Cif C/C++ Unit

[©] GDB Hardware Debugging

© AR C-SPY Applicatinn

& Launch Group New Configuration

Chapter 3 Managed Build Project Setup

=| - Press the 'Duplicate’ butt
3 - Press the 'Delete’ button |

7 - Press the 'Filter' button tc

isting ct

Export...
Duplicate
Delete

Link Prototype...
Unlink Prototype

Reset with Prototype Values

New Prot N . Eimayrativ
New launch ccnflgurat\cli

ration(s

ration(s

lective si

Filter matched 9 of 9 items

Figure 71 - New Configuration context menu item
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From the context menu select "New Configuration”. This should create a new debug configuration and

display it in the right pane.

= Debug Cenfigurations

Create, manage, and run configurations

o x

L

Fa@EX| BT -

Namne: | iar_manzged Debug

type filter text

C/C++ Application

[E Main| £ Setup | @ Download | [,y] Images | <% Plugins

&% Multicore | % Extra Options| & Source | [] Commen

Filter matched 10 of 10 items

5
@

Project:
[5] C/C++ Attach to Application z
C/C++ Cantainer Launcher [ior_managed | ‘ Browse. |
[E] C/C++ Postmortem Debugger || ¢/c++ Application:
E’,E" EE":D‘EAW““““” [ Debugiiar_managed.out
i C/Cr+ Uni
GDB Hardware Debugging Variables.. | SearchProject..|  Browse..
~ @ 14R C-SPY Application Build (i required) before launching
@ isr_managed Debug

. Launch Group Build C. Select -

(O Enable auto build O Disable auto build

®) Use workspace settings Configure Workspace Settings..

Revert Apply

Close

Figure 72 - IAR C-SPY debug configuration

By default the newly created configuration will be associated with the active project. In our example it
is also the only project in the workspace. However, if for some reason the wrong project or no project is

displayed in the "Project:” field click the "Browse” button to select the correct project from a list of

projects available in the workspace.
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= Project Selection

Choose a project to constrain the search for a program

=5 iar_managed

©)

Figure 73 - IAR C-SPY debug project selection

Select the desired project for this debug configuration and click "OK” to return to the debug
configuration panel.

Next let’s look at the debug connection setup by selecting the "Setup” pane.

S Debug Configurations

Create,

O
ge, and run confi i

CEeEX BT~

Mame: | iar_managed Debug
|typefi|tertext ‘ Main [ﬁ' Setupw @ Download | =] Imagesl & Plugmsl &¥ Multicore| /% Extra 0pt|ons| B Source| [ Commen
E C/C++ Application Project Sdk: 1AR Toolchain for ARM - (8.x), 8.30.0 (iar.sdkprovider.arm.vg) &
[T] C/C++ Attach to Application i
[E] C/C++ Container Launcher Device | NXP MCIMX7D7_A7 |
[E] C/Cr+ Postmortem Debugger Change device with Project > Select Device...
[E] C/C++ Remote Application
Cif ¢/C++ Unit Run to: | main |
[©] GDB Hardware Debugging
e @ IAR_ C-SPY Application [] Terminate debugger on program exit
g iar_managed Debug

. Launch Group [ Try to resolve aliases

Setup macros
[] Use macro file(s)

Device description file
[[] Override default

STOOLKIT_DIRS\COMFIG\debugger\NXP\MCIMX7D7_AT.ddf

Drriver Simulator

w

Simulator
CMSIS-DAP hd
|-jet/1-jet Trace
Filter matched 10 of 10 items ST-LINK
TI MSP-FET

T XD5
@

Debug Close

Figure 74 - IAR C-SPY debug setup
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By default IAR will launch a debug session into the IAR Simulator. To use a real hardware target a
suitable debug probe must be selected and configured. The exact configuration required for each target
and debug probe combination is beyond the scope of this guide. As an example this guide will use the

J-Link debug probe.

Once the proper debug probe is selected click "Debug” to launch the debug session.

= Confirm Perspective Switch

Switch to this perspective?

Remember my decision

'O' This kind of launch is configured to open the Debug perspective when it suspends.

This Debug perspective supports application debugging by providing views for
displaying the debug stack, variables and breakpoints.

*

No

Figure 75 - Eclipse switch perspective prompt

Eclipse will probably warn that launching a debug session is associated with the "Debug” perspective.
Clicking "Switch” will rearrange the selection of panels within Eclipse to show the views relevant to
debugging. Checking "Remember my decision” will stop Eclipse from asking the same question each

time a debug session is launched.

S eclipse_iar_workspace - iar_ managed/main.c - Eclipse IDE

# Detug
H-0-Q%- ™5 5~ <
45 Debug 52 [y Project Explorer
2 %| & T
~ @ iar_managed Debug [IAR C-SPY Application]
v 8 C-SPY [Ci/eclipse_jar_workspace/iar_managed,
v o Core 20 (Suspended)
= main() at main.c:4,2 (0x9100ed)
= [C/eclipse_iar_workspace/iar_managed’
Wi Chiar_armharmi.\commen' bin\CSpyServer2

< > <

File Edit Source Refactor Navigate Search Project Jlink Run Window Help
Q) iar_managed Debug

A IS RER ISR AN |
= O [g mainc 2

void main(void)

}

for(;s) {

i

= 8

| E@:2:w |

(x

»

)= Vanabl...

069180ed:

069180e8:

889180ec:
88918670:

88918074:

88918676 :
8691807a:
LR
66916160:
66918162:
90910164 :
00910106
00910108 :

9e9lelec:
©00910110:
00912114:
00912118
B@9lellc:
00912120:
0@912124:

g Break...

Enter location here V@ BBy

main:

B Console 52 [# Problems {3 Executables [G] C-SPY Debug Console
iar_managed Debug [IAR C-SPY Application]

C-SPY Server 2.@ (IAR IDE Platform 8.4.11.7894/W32, compiled with MSWC 19.8.24215.1 on Nov 25 2826 @1:456:38 A
Build tag: jenkins_8_4 x_nightly_116

B

LDR.W
DC32

B.W

PUSH
NOP .1
MOVS
MOVT
MOV
MOVS
SVC
B.N

MOVS
MOVS
BLX
B
DC32
DC32
DC32
DC32

]}

Service registry running on named pipe: \\.\pipe\iar-cspy-java-SERVICE_REGISTRY-Bc579fdc-62a4-dedd-alfc-242
Configuring CSpyServer as multicore session owner.

- o x
[ e &

Q iE|
6 Expres... B Disass.. 1 GC-SPY.. = O

A
main:
main ; @x91'08ed
eneer @ (6) for _exit:
PC, [PC, #8x8] ; _exit
_exit
exit:
Weneer @ (6) for _exit ;
_exit:
{R7, LR}

@x91'@8es

R3, #38

R3, #2

R, R3

RO, #24

#oab

ox91' 2100
_exit:

R7, R®

RO, R7

_ exit

ox91'0110

oxesaf fols

5 @x26

5 @18

; @xo1'eefs

exesaf ' fols
exesaf ' fols
oxesaf'fols v

xR EE~2re-85-=0

v
>

Figure 76 - IAR Eclipse C-SPY debug session

If all goes well, the debug session should now be active with the application halted at the main function
created in the previous section. Pressing the stop button will terminate the current debug session. It is
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also possible to return to the C/C++ perspective by clicking the icon next to the small green bug near
the top right corner of the IDE.
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Makefile Project Setup

Contrary to a managed build project where the IDE is responsible for compiling the source code and
linking the application binary, a Makefile project delegate those tasks to the user. It is possible to create
a Makefile project using the IAR Eclipse plugin. However the steps are slightly different compared to the
usual Eclipse Makefile project.

This section will focus on the steps that must be performed within Eclipse to get a Makefile project
working. Additional information on how to write a Makefile for the IAR tools can be found on our
website here.

4.1 IAR Eclipse Makefile Project

The first step is to create a managed build project in the exact same way as was done in the previous
section. Then we'll modify the project configuration to use a custom Makefile instead of
auto-generating one.

Start by opening the new C/C++ Project dialog from the "File->New->C/C++ Project” menu item.
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— eclipse_iar_workspace - Eclipse IDE
File Edit Source Refactor MNavigate Search Project Run  Window Help
New Alt+Shift«N » [T¥ Makefile Project with Existing Code i
Open File... [€] C/C++ Project
) Open Projects from File System... ™ Project.. | Create a new C or C++ project i
[entlis ’ Convertto a C/C++ Autotools Project
Close Editor Ctrl+W Convertto a C/C++ Project (Adds C/C++ Nature)
Close All Editors Ctrl+Shift+W | &% Source Folder
Save Ctrl+5 [ Folder
o .
Save As.. &{; Source File
Save Al CtrleShiftes | ] HeaderFile
& =
Revert | Filefrem Template
& Class
Mave...
[ Rename.. F2 O Example..
& | Refresh F5 |9 Other. Ctrl+N
Convert Line Delimiters To >
Figure 77 - New C/C++ project menu item
This should open the new project dialog.
= MNew C/C++ Project O 4
Templates for New C/C++ Project
C Managed Build ~

CMake
Make
Meson

A C Project build using the COT's managed build system.

A

‘ l L. . R SR Y

£ >

C++ Managed Build
A C++ Project build using the CDT's managed build system.

CMake Project
A CMake project with a Hello World executable to get started

Empty or Existing CMake Project
Create @ CMake project with no files. Can be
used to create one over existing content.

Empty or Existing Meson Project
Create @ Meson project with no files. Can be

Q)

< Back Finish Cancel

Figure 78 - New C/C++ project dialog

Select "C Managed Build” and click "Next” to go to the project type and name configuration.
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Type a name for the new project, this example uses "iar_makefile” as a project name.

@& Empty Project
@& Hello World ANSI C Project
~ [= Executable (IAR)

& Empty Project

@& Project with empty main()
= Library (IAR)
== Shared Library
= Static Library

== Makefile project A

— m|
C Project —
Create C project of selected type
Project name: iar_makefilel
Use default location
Checlipse_iar_workspacehiar_makefile Browse...
default
Project type: Toolchains:
(= GNU Autoteols - IAR Toolchain for ARM - (8.x)
v [= Bxecutable IAR Toolchain for ARM - (legacy, 7.x)

Show project types and toolchains only if they are supported on the platferm

(?3' < Back Mext > Cancel

Figure 79 - New project name and type

In the project type panel (the left pane) expand the "Executable (IAR)” category and select "Empty
Project”. In the right pane make sure to select "IAR Toolchain for ARM - (8.x)".

Click "Next” to continue the wizard. The project build configurations panel should be displayed.
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— O x
Select Configurations

Select platforms and cenfigurations you wish to deploy on

Project type: Executable (IAR)
Toolchains: AR Toolchain for ARM - (8.)

Configurations:

@ Debug

Select all
%3 Release

Deselect all

Advanced settings...

Use "Advanced settings” button to edit project's properties.

Additienal configurations can be added after project creation.
Use "Manage configurations” buttons either on toolbar or on property pages.

l:?jl < Back Mext > Cancel

Figure 80 - New project build configurations

No changes should be performed in this panel so click "Next” again to continue.

= ] X
IAR Device Selection

Select a device

Device
NXP MCIMXTD7_AT | [Browse...|
':?:' < Back Mext = Finish Cancel

Figure 81 - New project device selection dialog

From the device selection dialog click "Browse” to select the MCU or SoC to target with this project.
This example will use the NXP i.MX 7 SoC but any other supported MCU can be used.

Click "Finish” to end the wizard and create the new project. The newly created project should appear in
the workspace.
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{;vag-v%v@L RS - -
[ Project Explorer 32 = 0O

=% 7 8
=5 iar_makefile
125 iar_mana New >
Go Into
Open in New Window
Show In Alt+Shift+W »
Show in Local Terminal >
Copy Ctrl+C
Paste Crl+V
3 Delete Delete
Source ]
Move...
Rename... F2
Import...
Export...
Build Project
Clean Project
Refresh F5
Close Project
Close Unrelated Project = [
Build Targets > |atth
Index ]
Build Configurations 3
Profiling Tools ]
Q@ Runas 3
= - § Debug As »
= iar_makefile §
Profile As »

Restore from Local History...

Select Device...

C-STAT Static Analysis »
Run C/C++ Code Analysis

Team >
Compare With 3
Validate

Configure 3

Source 3

Properties Alt+Enter

Figure 82 - Project properties context menu item

Right click the newly created project and select the "Properties” item from the context menu.
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= Properties for iar_makefile O X
type filter text Tool Chain Editor f=lhe v 3
Resource
Builders
~ CfC++ Build Configuration: | Debug [ Active | ~ | | Manage Configurations...

Build Variables
Environment

Logglng [] Display compatible toolchains only
Settings
Tool Chain Editor Current teolchain: | IAR Toolchain for ARM - (8x) w

C/C++ General
C-5PY

C-STAT Static Analysis
Linux Tools Path

Current builder: COT Internal Builder ~

Autotools Makefile Generator
CDT Internal Builder

Project Matures Used tools

Project References IAR C/C++ Compiler for ARM Select Tools...
Run/Debug Settings IAR Assembler for ARM

Task Repository IAR Linker for ARM

Task Tags IAR Library Builder for ARM

Validation

WikiText

Restore Defaults Apply

@ Apply and Close Cancel

Figure 83 - Project properties tool chain editor

In the project properties screen navigate to the "C/C++ Build->Tool Chain Editor” category. In the
displayed panel change the "Current builder:” selection to "Gnu Make Builder”.

Now open the "Settings” category and open the "Error Parsers” pane. It's possible that the pane isn’t
displayed in which case two arrows will be displayed next to the panes tabs that can be used to navigate
through the tabs.

S Properties for iar_makefile m] x
Settings P
Resource
A
Builders
~v C/C++ Build Configuration: Debug [ Active ] | | Manage Cenfigurations...

Build Varizbles
Environment

Logging i Tool Settings [J Container Settings #* Build Steps Build Artifact Binary Parsers @ Error Parsers
Settings
Tool Chain Editor £=GNU gmake Error Parser 7.0 Add...
C/Cr+ General = pushd/popd CWD Locator
C-spv <=|AR Error Parser Edit...

C-STAT Static Analysis
Linux Tools Path
Project Natures
Project References
Run/Debug Settings
Task Repository

Task Tags

Validation

WikiText

[ <= Autoconf Error Parser

[ <= GNU Assembler Error Parser
[ = GNU Linker Error Parser

] == GNU geesfg++ Error Parser Move Up
[[] ©=Microsoft Visual C Error Parser

O f)éGNU gmake Error Parser 6.0 (Deprecated)

Delete

Move Down

@' Apply and Close Cancel

Figure 84 - Project properties error parsers settings
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In the Error Parsers panel make sure that "GNU gmake Error Parser 7.0" and "IAR Error Parser” are
checked. This will help CDT parse the build errors correctly and enable jumping to the source of an
error from the console by double clicking on a displayed build error.

Now open the "C/C++ Build” root category.

= Properties for iar_makefile m] x
¢/c-» Build PR
Resource
. A
Builders
« C/C++ Build Configuration: Debug [ Active ] ~ | | Manage Cenfigurations...
Build Varizbles
Enviranment
Logging [El Builder Settings @ Behavior ¥ Refresh Palicy
Settings .
Tool Chain Editor Builder
C/C++ General Builder type: External builder
c-spv . . [A Use default build command
C-5TAT Static Analysis
Linux Tools Path Build command: = make Variables...
Project Natures
Project References Makefile generation
Run/Debug Settings [] Generate Makefiles automatically Expand Env. Variable Refs in Makefiles
Tesk Repository Build location
Task Tags
Validation Build directory: ‘ S{wnrkspa(e_ln(1_a'iar_makefile}f1
WikiText
e Workspace... | | File system... | | Variables...
Restore Defaults Apply N
A
L) Apply and Close Cancel

Figure 85 - Project properties build settings

From the "Builder Settings” pane uncheck "Generate Makefile automatically”. Also modify the build
location to point to the root of the project created earlier in this section. For the example project that
was named "iar_makefile” the resulting path should be "${workspace_loc:/iar_makefile}/"

Click "Apply and Close”

to save the settings and return to the workspace.

I Project Explorer £32 = 0
ES
v 25 jar malefils
& New * [ Project..
-« Go Into 5 R
Eia ile
Open in New Window “ Filefrom Temnplate =
Create a new file resource

Show In Alt+Shift+W > 9 Folder
Show in Local Terminal b @ Class

[& Copy Ctrl+C h  Header File
Paste Ctrl+V ¢/ Source File

K Delete Delete &% Source Folder
Source  [E] C/Ce+ Project
TR Convert to a C/C++ Project (Adds C/C++ Nature)
Rename... F2

™ Example...

[ Import..

4 Export ™ Other... Ctrl+N
Build Project [

Figure 86 - Add new file context menu item
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Now let’s create a dummy source file to build. Right click on the project and select the "New->File”
context menu item.

= Create New File O X

File

Create a new file resource.

Enter or select the parent folder

iar_makefile

=5 iar_makefile
= iar_managed

File name: | main.c|

Advanced = >

Figure 87 - Add new file dialog

Type the name "main.c” as the source file name and click "Finish”. The new empty file should open in the
IDE.
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3 eclipse_iar_workspace - iar_makefile/main.c - Eclipse IDE - m] x
File Edit Source Refactor MNavigate Search Project Run  Window Help
45 Debug @ izr_makefile2 Debug i ‘ Br® @ Biw BB @
H-0-Q Q- @0 S-[HBRE T K- - CTED | Q im|[E
[ Project Explorer £2 = B [g mainc 2 = 0 gECutl. ¥ @Buil. = O
BESY || 1 i maincvosd v BBV o ¥ §
w25 jar_makefile ; void main(void) @ main(void) : void
[l Includes a4 for(;;) {
[ main.c 5
& NXP MCIMXTD7_AT 6 H
=% iar_managed : I}
[# Problems =] Tasks E) Console 3 [ Properties [G] C-SPY Debug Console ¥ S = 08
Mo consoles te display at this time.
Writable Srnart Insert 8:1:43

Figure 88 - Example main with infinite loop

For the purpose of this example let’s populate the source file with a dummy main function with an
infinite loop.

IAR Embedded Workbench Eclipse Setup Guide www.jblopen.com


https://www.jblopen.com

JBLopen

Embedded Software Insight Chapter 4  Makefile Project Setup | 56
void main(void)
for(55) {
Listing 2 - Example main function with infinite loop
e eclipse_iar_workspace - iar_makefile/makefile - Eclipse IDE - m] x
File Edit Source Refactor Mavigate Search Project Run  Window Help
|{;‘~Debug V||@iar,makeﬂle20ebug v | i ‘ I A = Y G E @~
H-0 - - S RET I F D e Q e ||REl
Iy Project Explorer &3 = 8 [g mainc L@ makefile E2 = 0O E= Outline 22 @Build.. = O
=] (§> '-l_f‘ 3 1# Intermediary objects working directory. = iﬁz g
< - 2 0BIDIR := obj i
w [ iar_makefile 3 & OBIDIR
6! Includes 4# Name of the output binary executable file. ® LINK_TARGET
€ main.c 5 LINK_TARGET := a.out @ APP_SOURCE
A% NXP MCIMX7D7_A7 6 & CC
[ makefile ;:P;pgéaggélcn source files list. & LD
=% iar_managed 5 = = main.c @& C_FLAGS
1@# Name of toolchain executables to use. ® LINK_FLAGS
11CC := iccarm.exe @ INCLUDEDIR
121D := ilinkarm.exe @ SOURCE
1= ® OB
14# C Build flags. @ all
15 C_FLAGS := -e --cpu Cortex-A7 --fpu VFPv4 --debug --endian little --cpu_mode arm -On v
16 = @echo All done
17 # Link flags. ~ (@ S(LINK_TARGET)

18 LINK_FLAGS :=
19

20 # Configure include directories.
21 INCLUDEDIR = -I$(subst \,/,3(PuD))

--config C:/iar_arm/arm/config/linker/NXP/MCIMX7D_A7.icf

22

23# Extract all the C source file names.
24 SOURCE += $(notdir $(APP_SOURCE))

25

26 # Compute intermediary object names.
27087 += $(SOURCE:%.c=$(0BIDIR}/%.0)
28

<

[ Problems =] Tasks B Console 32 [ Properties [8] C-SPY Debug Console

Mo consoles to display at this time.

wv

wv

w

> S(LD) -0 $@ $* S(LINK_FLA ...
(@ S(OBJDIR)/%.0

B S[CC) ${C_FLAGS) S(INCLUD .
(@ S(OBIDIR)

= midir S(ORIDIR)
O PHONY
(@) clean

= rm -rf S{OBJDIR}

B rm -of S(LINK_TARGET)

>

+ B -~ = 08

| writable | smart Insert | 5:21:126

Figure 89 - Example makefile

Next add another file to the project named either "Makefile” or "makefile” and copy the content of the
example makefile below. Additional information on writing a Makefile using the IAR tools can be found

on our website here.
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# Intermediary objects working directory.
OBJIDIR := obj

# Name of the output binary executable file.
LINK_TARGET := a.out

# Application source files list.
APP_SOURCE := main.c

# Name of toolchain executables to use.
CC := qdccarm.exe
LD := dilinkarm.exe

# C Build flags.
C_FLAGS := -e --cpu Cortex-A7 --fpu VFPv4 --debug --endian little --cpu_mode arm
-0On

# Link flags.
LINK_FLAGS := --config C:/iar_arm/arm/config/linker/NXP/MCIMX7D_A7.icf

# Configure include directories.
INCLUDEDIR = -I$(subst \,/,$(PWD))

# Extract all the C source file names.
SOURCE += $(notdir $(APP_SOURCE))

# Compute +intermediary object names.
OBJ += $(SOURCE:%.c=$(0BJIDIR)/%.0)

# Build everything.
all : $(OBJIDIR) $(LINK_TARGET)
@echo A1l done

# Firmware binary linking.
$ (LINK_TARGET) : $(OB3J)
$(LD) -o $@ $" $(LINK_FLAGS)

# C files build.
$(OBJIDIR) /%.0 : %.c | $(OBJIDIR)
$(CC) $(C_FLAGS) $(INCLUDEDIR) -o $@ -c $<;

$ (0OBIDIR)
mkdir $(OBJIDIR)

.PHONY: clean
clean:
rm -rf ${OBJDIR}
rm -rf $(LINK_TARGET)
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N =
HE Q- Q@™o 5 5 R
I Project Explorer i3 = B [g mainc | @ makefile 52
New > pcts working dir
v IS iarr Go Into
It P
% j Open in New Window 3: binary execut
& Show In Alt+Shift+W »
[&r Show in Local Terminal » fe files list.
. .C
=5 jar_r
=] Cof Ctrl+C
= = ~ p executables tc
Paste Ctrl+V
¥ Delete Delete
Source ¥
Move... u Cortex-A7 --fp
Rename... F2
By Import... nfig C:/iar_arm/
g Export. E directories.
ubst \,/,3(PWD))
Build Project | Incremental Build of Selected Projects i )
Clean Project oorees tile nz
$(APP_SOURCE))
Refresh F5
Clseprojec ooy cotess oo

Figure 90 - Build project context menu item

With everything set up right-click again on the project and select "Build Project” from the context menu.
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: eclipse_iar_workspace - iar_makefile/makefile - Eclipse IDE - m] x

File Edit Source Refactor MNavigate Search Project Run  Window Help

45 Debug @ iar_makefile2 Debug [ | ® -/~ B CAIEEE @

F-0--Q@-®5 - -G e Q E||Ew
[y Project Explorer &3 = 8 [f mainc @ makefile &3 = 0O gF Outline 32 @Build.. = O
=% 7 8 1# ?nte'n'ediajy objects working directory. ~ az g
v (25 iar_makefile Z0mI0IR += ob] © OEIDR A
B
i, Binaries 4# Name of the output binary executable file. ® LINK_TARGET
[ Includes 5 LINK_TARGET := a.out & APP_SOURCE
= obj 6 ® CC
[ main.c 7 # Application source files list. & LD
¥ s.0ut - [arm/le] ;"PP—SDURCE T maAn-© ® C_FLAGS
4 NXP MCIMXTDT_A7 1le# Name of toolchain executables to use. @ LINK_FLAGS
& makefile 11CC := iccarm.exe & INCLUDEDIR
=% iar_managed 121D := ilinkarm.exe @& SOURCE
13
1448 £ Ruild Flane e © OB v
< > < >
[8} Problems =] Tasks B Conscle 2 [ Properties [G] C-SPY Debug Console S@‘ EURE T <§.}‘ H @H =" @' B8-S = 0
COT Build Console [iar_makefile]
A
Errors: none
Warnings: none
ilinkarm.exe -o¢ a.out obj/main.o --cenfig C:/iar_arm/arm/config/linker/NXP/MCIMX7D_A7.icf
IAR ELF Linker V3.58.9.278/W32 for ARM
Copyright 20887-2828 TAR Systems AB.
338 bytes of readonly code memory
68 bytes of readwrite code memory
82 bytes of readonly data memory
8'704 bytes of readwrite data memory
Errors: none
Warnings: none
Link time: 8.85 (CPU) @.85 (elapsed)
All done
89:54:44 Build Finished. @ errors, @ warnings. (took 556ms)
~

= iar_makefile

Figure 91 - Project built successfully

If all went well the project should now be built and ready to be loaded onto a target and debugged.

4.2 IAR Eclipse Makefile Project Debugging

With the Makefile project properly set up and built, it's now time to create a debug configuration. The
instructions are very similar to creating a debug configuration for a managed build project except that it
is important to properly set the project and binary file to debug as they may not be detected
automatically.

Start by searching for and clicking the "Run->Debug Configurations” menu. Note that while it is possible
to create a debug configuration by right-clicking the project root and selecting "Debug as” this will
launch a debug session without having the chance to configure it first which is almost certainly not the
desired outcome.
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r_makefile/makefile - Eclipse IDE

r Mavigate Search Project  Run  Window Help

bug v”@ iarm @ Run Ctrl+F11 | ® -~ ]
L 3% Debug F11
@B ¥ -iFE @ Profile
= 5 i |
4 mEnE 8™ pofile History >
'1? g 1# Inte’rredla'l;- .
20BIDIR := obj Profile As H
3 Profile Configurations...
4% Name of the .
S LINK_TARGET :- C++ Exceptions >
6 ;
74# Application Run History 2
B APP_SOURCE := (3 RunAs 5
9 . -
18 % Name of tool Run Configuratiens...
11CC := iccarm.¢ .
12 LD := ilinkarr Debuglhistony 2
13 3&3}: Debug As >
14 % C Build flag -
15C_FLAGS := -e B e e idian littl
16 .
Breakpoint T ¥
17# Link flags. HE e L=
13 LINK FLAGS := Teggle Breakpoint Ctrl+5hift+B P/MCIMXTD
284 Configure i Toggle Line Breakpoint
21 INCLUDEDIR = - Toggle Watchpoint
22
23# Ewtract all Teggle Method Breakpoint
24 S50URCE += $(n¢ ‘g Skip All Breakpoints Ctrl+Alt+B
25
AE £ FomnEe §nid Remove All Breakpoints
N q External Tools >
[ Problems | Tasks——ege s 1) Trows 121 - Console

COT Build Console [iar_makefile]

Figure 92 - Debug configurations menu item

The "Debug Configurations” panel should appear.

[ ] T T LS Launs
[€] C/T++ Postrortem Debuge || [1Z] - Press the 'Duplicate’ button
[€] C/C++ Remote Application
Cif C/C++ Unit
[c] GDB Hardware Debugging '1? - Press the 'Filter' button to ©

~ @ AR C-SPY [

3 - Press the 'Delete’ button to

) . MNew Configuration isting corr
@ iar_man o
i Launch Gre = ﬂ Mew launch configuration h nfiguration
@ Export..
fi i

Duplicate nfiguration
Delete nfiguration

L| Link Prototype... ]
pective sett

u  Unlink Prototype

r| Reset with Prototype Values

Figure 93 - New IAR C-SPY debug configuration context menu item

On this panel right-click "IAR C-SPY Application”.
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From the context menu select "New Configuration”. This should create a new configuration which
should be displayed on the right panel.

= Debug Configurations m] *
Create, manage, and run configurations . ?

B EX| BV - Name: [ iar_mskefile Debug |
|t}peﬂ|tertaxt | [ Main % Setup| @ Download | [,j] Images| =% Plugins | &% Multicore ] Common | & Source| % Extra Options

[€] C/C++ Application Project:

[€] C/C++ Attach to Application

[] C/C++ Container Launcher | iar_makefile T B2

[€] C/C++ Postmortem Debugger C/C+~ Application:

[€] C/C++ Remote Application | aout

Cif C/C++ Unit
[ GDB Hardware Debugging Variables... Search Project... Browse...
v @ 1AR C-5PY Application
@ iar_makefile Debug

@ iar_managed Debug Build Configuration: | Use Active

@ Launch Group

Build {if required) before launching

(_) Enable aute build () Disable aute build
(®) Use workspace settings Configure Workspace Settings...

Revert Appl
Filter matched 11 of 12 items evel pply

@

Figure 94 - New IAR C-SPY debug configuration

By default the new configuration is associated with the active project. If the project named in the
"Project:” field is not the correct one, or the field is empty, click "Browse...” next to it to select a project.

= Project Selection O *

Choose a project to constrain the search for a program

= iar_makefile
=

iar_managed

(3

Figure 95 - Debug project selection dialog

Select the desired project from the "Project Selection” dialog and click "OK”".

In a similar fashion, verify that the "C/C++ Application:” field points to the correct executable binary to
debug. If it is incorrect or left empty click "Browse...” underneath the field to select a binary file.
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— Program Selection

Cheoose a program to run:

Binaries:

Oa.out

Qualifier:
3‘@: armle - fiar_makefile/a.out

Figure 96 - Debug program selection dialog

From the selection dialog select the binary file to debug. If nothing is displayed make sure that the
project was built correctly. Also if the binary file has an unknown extension, other than ".out” or ".axf"
for example, it may be necessary to manually type the name of the file instead. Once done click "OK".

Now select the "Setup” tab to display the debug setup configuration panel.
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= Debug Configurations

FeRX| BT~

|t,:pefilter text |
[€] C/C++ Application
[] C/C++ Attach to Application
[€] C/C++ Container Launcher
[€] C/C++ Postmortem Debugger
[€] C/C++ Remote Application
Cif C/C++ Unit
[£] GDB Hardware Debugging
~ € 1AR C-5PY Application

@ iar_makefile Debug

@ iar_managed Debug
R Launch Group

Filter matched 11 of 12 items

~
@

Create, manage, and run configurations

Name: | iar_makefile Debug

[E] Main | ¥ Setup| @ Download | [j] Images| =% Plugins | ¥ Multicore ] Common | - Source| % Extra Options

Project Sdk: AR Toolchain for ARM - (8.x), 8.30.0 (iar.sdkprovider.arm.v8)

Device ‘ NXP MCIMX7D7_A7

Change device with Project > Select Device...

Run to: | main

[A Terminate debugger on program exit
TrytD resolve aliases

Setup macros
[ Use macre file(s)

Device description file
[ Override default

STOOLKIT_DIRS\CONFIG\debugger\NXP\MCIMX7D7_AT7.ddf

Driver Simulatar

w

TI MSP-FET
T XDS

Simulator ™
CMSIS-DAP

|-jet/|-jet Trace

ST-LINK

Figure 97 - Debug setup panel

By default IAR will launch the executable file using the IAR simulator. To debug a hardware target make
sure to select the correct debug probe. This example uses the Segger J-Link debug probe but any
supported probe can be used.

Also make sure that the correct device is mentioned in the device field. If the incorrect device is
displayed or the field is empty, it is possible to select a device for the current project using the
"Project->Select Device..” menu item from the main IDE screen.

If all is well click "Debug” to launch the debug session.

= Confirm Perspective Switch

Switch to this perspective?

Remember my decision

| This kind of launch is configured to open the Debug perspective when it suspends,

This Debug perspective supports application debugging by providing views for
displaying the debug stack, variables and breakpoints,

T [

X

Figure 98 - Eclipse switch perspective prompt
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Eclipse will probably warn that launching a debug session is associated with the "Debug” perspective.
Clicking switch will rearrange the selection of panels within Eclipse to show the panels relevant to
debugging. Checking "Remember my decision” will stop Eclipse from asking the same question each

time a debug session is launched.

= eclipse_iar_workspace - iar_makefile/main.c - Eclipse IDE

File Edit Source Refactor Mavigate

% Debug
H-0-Q-®D ¥~ -
7{;: Debug &% i Project Explorer
B%| 2T i 8

~ @ iar_makefile Debug [IAR C-SPY Application]

v U’E C-5PY [Ci/eclipse_iar_workspacefiar_makefile/i 5

w o Core 20 (Suspended]

main() at main.c:4,2 (0x%100e4)
[C:/eclipse_iar_workspace/iar_makefile/a

T R TR

w Chiar_armharmb.\commontbin\CSpyServer2

o =l

< > <

Search Project JLink Run
g iar_makefile Debug

= O [g mainc 53 [g makefile

B Console 52 [&] Problems (3 Executables [E] c-spy Debug Consale
iar_makefile Debug [IAR C-5PY Application]

Writable Smart Insert 4:5:23

- m} X
Window Help
il | BiBisn|mnE . R &
oD oo Q im| mE
= B ®-Variabl.. ®g Bresk.. & Expres.. =¥ Disass.. I € C-SPY.. = 0
Enter location here v ‘ &t S |Q>| i 8
=void main(void) main: R
- 6091604 : main:
for(is) { * B main ; Bx91'eBed
} 289188e8: MWeneer @ (6) for _exit:
! LDR. W PC, [PC, #ox@] ; _exit
Ba9188ec: DC32 _exit
eegleafe: exit:
B.W #veneer @ (6) for _exit ; ox91'@@ed
eoo166T4: _ exit:
MOV R1, #38 ; Bx26
e@p91eeTs: MOVT R1, #2
epoleefc: MOV R@, %24 3 Bx18
8a918188: SVC #Bx123456
eeol1e1e4: B _ exit 3 @x91'eafa
918188 _exit:
MOVS R7, R@
eeolelec: MOVS R, R7
22910110: BL _ exit 3 8x9l1'eefa
88918114 : B B8x91'9118
8@918118: DC32 Bxe59f " fa18
@@918llc: DC32 exe5of ' fol1s
88918128: DC32 Bxe50T ' fo18
ea91a124: DC32 Bxe59f " fa18
88918128: DC32 Bxe5of fals
e@91812c: DC32 exe
8a9181308: DC32 Bxe59f " fal4 W

B EREE ~2~-8-=0

-~

C-SPY Server 2.8 (IAR IDE Platform 8.4.11.7894/W32, compiled with MSVC 19.8.24215.1 on Nov 25 2028 @1:46:38
Build tag: jenkins_3_4 x nightly 116

Service registry running on named pipe: ‘\.\pipe‘\iar-cspy-java-SERVICE_REGISTRY-eB8b32d1f-3954-4f93-3cd@-73c
Configuring CSpyServer as multicore session owner.

w
>

Figure 99 - Debug session

If all went well, the project should now be loaded on that target and the debugger halted at the main

loop.
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